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Preface

Optegra 15.0 Release Notes include product information that you should note
before using Optegra applications.

Book Conventions
The following table illustrates and explains conventions used in writing about
Optegra applications.
Convention

Example

Explanation

EPD_HOME

cd $EPD_HOME/install

Represents the default path where the current
version of the product is installed.

(UNIX)

cd %EPD_HOME%\install
(Windows)
Menu selections

Vault > Check Out > Lock

Indicates a command that you can choose from
a menu.

Command buttons and
options

Mandatory check box, Add button,
Description text box

Names selectable items from dialog boxes:
options, buttons, toggles, text boxes, and
switches.

User input and code

Wheel_Assy_details

Enter the text in a text box or on a command
line.

-xvf /dev/rst0
Enter command> plot_config

Where system output and user input are mixed,
user input is in bold.

System output

CT_struct.aename

Indicates system responses.

Parameter and variable
names

tar -cvf /dev/rst0 filename Supply an appropriate substitute for each

Commands and keywords

The ciaddobj command creates an
instance of a binder.

parameter or variable; for example, replace
filename with an actual file name.
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Convention

Example

Explanation

Text string

"SRFGROUPA" or ’SRFGROUPA’

Shows text strings. Enclose text strings with
single or double quotation marks.

Integer

n

Supply an integer for n.

Real number

x

Supply a real number for x.

#

# mkdir /cdrom

Indicates the root (superuser) prompt on
command lines.

%

% rlogin remote_system_name -l Indicates the C shell prompt on command
lines.
root

$

$ rlogin remote_system_name -l

root

Indicates the Bourne shell prompt on command
lines.

>

> copy filename

Indicates the MS-DOS prompt on command
lines.

Keystrokes

Return or Control-g

Indicates the keys to press on a keyboard.

Online User Documentation
Online documentation for each Optegra book is provided in HTML if the
documentation CD-ROM is installed. You can view the online documentation
from an HTML browser or from the HELP command.
You can also view the online documentation directly from the CD-ROM without
installing it.
From an HTML Browser:
1.

Navigate to the directory where the documents are installed. For example,
$EPD_HOME/data/html/htmldoc/ (UNIX)
%EPD_HOME%\data\html\htmldoc\ (Windows)

2.

Click mainmenu.html. A list of available Optegra documentation appears.

3.

Click the book title you want to view.

From the HELP Command:

To view the online documentation for your specific application, click HELP.
(Consult the documentation specific to your application for more information.)
From the Documentation CD-ROM:

vi

1.

Mount the documentation CD-ROM.

2.

Point your browser to:
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CDROM_mount_point/htmldoc/mainmenu.html

(UNIX)

CDROM_Drive:\htmldoc\mainmenu.html (Windows)

Printing Documentation
A PDF (Portable Document Format) file is included on the CD-ROM for each
online book. See the first page of each online book for the document number
referenced in the PDF file name. Check with your system administrator if you need
more information.
You must have Acrobat Reader installed to view and print PDF files.
The default documentation directories are:
• $EPD_HOME/data/html/pdf/doc_number.pdf (UNIX)
• %EPD_HOME%\data\html\pdf\doc_number.pdf (Windows)

Resources and Services
For resources and services to help you with PTC (Parametric Technology
Corporation) software products, see the PTC Customer Service Guide. It includes
instructions for using the World Wide Web or fax transmissions for customer
support.

Documentation Comments
PTC welcomes your suggestions and comments. You can send feedback
electronically to doc-webhelp@ptc.com.
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Chapter 1

Issues and Considerations

This chapter describes issues and considerations while using Optegra 15.0. These
issues and considerations are grouped by product.
• General Product Information
• EPD.Connect
• Vault
• Future Support for Optegra PC Client
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General Product Information
This section describes issues and considerations related to the build and product
versions, browser settings, JDK and Oracle versions, portmapper, CADDS 5 on
Solaris with EPD.Connect, and licenses on UNIX.

Build Version for EPD.Connect and Optegra Vault
To obtain the build version for EPD.Connect and Optegra Vault, follow the
instructions for UNIX or Windows.
On UNIX, read the version file, $EPD_HOME/data/Version. The default path
is /opt/epd/dm/v15/data/Version.
On Windows, perform the following steps:
1.

Run the regedit utility.

2.

Trace the build version number using the value of the Install Build key at
the following location:
<My Computer>
<HKEY_LOCAL_MACHINE>
<SOFTWARE>
<Parametric Technology Corporation>
<product-of-interest>
<Version-Language>

For example,
<My Computer>
<HKEY_LOCAL_MACHINE>
<SOFTWARE>
<Parametric Technology Corporation>
<EPD.Connect>
<15.0-French>

Product Version
The default value of $EPD_HOME is /opt/epd/dm/v15 on UNIX and
\EPD\DM\v15 on Windows. The product version directory is automatically
updated during installation.
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Browser Settings for Java and Help
Before using the HTML Help, enable Java and JavaScript in your browser
preferences. With these settings, you can use the Main Menu, Contents, Index,
Search, and Reset commands in the navigator panel of the Help.

JDK Upgrade
CADDS and Optegra Release 15.0 support JDK version 1.5.0_06.

Optegra Support for Oracle 10g
Optegra supports Oracle version 10g with the Oracle patch 10.2.0.3.

Portmapper for CADDS and Optegra
The installation of CADDS and Optegra on Windows uses a common portmapper
called Proportmapper. If you have an earlier release of Optegra installed, you must
check the portmapper service. If you have the Noblenet portmapper installed, you
must stop Noblenet and uninstall it with the portinst utility. The installer then
automatically installs and configures Proportmapper for the current release of
Optegra on Windows. For CADDS, the installer automatically stops and removes
the previous ONC portmapper.

CADDS 5 on Sun Solaris with EPD.Connect
You must have the following settings to improve the performance of CADDS 5 on
Solaris with EPD.Connect.

Setting the ndd (1M) Parameter
To improve the performance of CADDS 5 on Solaris, PTC recommends setting the
ndd (1M) parameter:
/usr/sbin/ndd -set /dev/tcp tcp_naglim_def 1

Please note: After you change the ndd (1M) setting, you need not restart the
system.
To make the tcp_naglim_def parameter permanent, add the ndd parameter at
the end of the /etc/rc2.d/S69inet file.
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CADDS 5 uses the /usr/tmp symbolic link for all temporary files, which affects
the speed of CADDS 5 on Sun Solaris. To improve the performance of CADDS 5,
make the /usr/tmp link point to the /tmp directory for all temporary files as
follows:
• Set the following environment variable in the .caddsrc-local or .caddsrc
file:
setenv CV_DB_TMPDIR

'/tmp'

• Create the following link:
ln -s /tmp /usr/tmp

Gamma Correction for the TIS Window
If you have set the CV_PLATFORM environment variable to ogl mode in the
caddsrc-local file, change the gamma correction value to control color fading
on Solaris 8 by using the following command:
/usr/sbin/fbconfig -g <value>

If you use the default gamma correction value 2.2, the Text Input Screen (TIS)
window appears faded compared to the other CADDS 5 windows. To view a TIS
window with the same color as that of CADDS 5, set the gamma correction value
to a value from 0.9 to 10.

LM_LICENSE_FILE on UNIX
When you set the LM_LICENSE_FILE environment variable on UNIX using
setenv LM_LICENSE_FILE file1:file2:file3:....:filen

the applications that use the license try to obtain the license key from file1. If the
license key is not found in file1, the application tries to get the license key from
file2, or file3, and so on. After the application obtains the license key, any spawned
applications or license calls and requests made by the applications for checking
out other license features are locked to the same license server.

1-4

Optegra 15.0 Release Notes

Issues and Considerations
EPD.Connect

EPD.Connect
This section describes some issues and considerations while using EPD.Connect.

Location of the optegra.ini File
On Windows, the optegra.ini file required by the Common Login is in the
Profile directory of the current user, as indicated by the %USERPROFILE%
environment variable, for example, C:\Documents and Settings\<User>.
Please note: The Common Login does not use the optegra.ini file created
by the installer in the Windows system directory. This file only stores licensing
information.
For details about the Common Login, refer to Chapter 5, “Common Login,” of
Installing Optegra Applications.

Classes with Different Children Cause Problems
In EPD.Connect, as a good practice, do not create instances of a class with
different children. These structures can lead to inconsistent product structures.
They can also cause problems while using other applications, like CAMU, where
they would be translated as is.

navsetup Script
The navsetup script is no longer shipped. A single cab binary for the supported
releases of CADDS 5 is installed in $EPD_HOME/install.
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Vault
This section describes some issues and considerations while using Vault.

Vault Programming
SVedm Programmatic Interface Dependency on Oracle
Client for Windows
The SVedm programmatic interface is not dependent on the Oracle Client at
runtime for Windows and ORASQL10.dll. Refer to the sample makefile,
svedmsample.mak, for the changes that require the linking of the custom
programs to the edmstubs.a library.

Edit User Attributes Dialog Box within the EDMGUI
You cannot access the Edit User Attributes dialog box using the Edit > User
Attributes, View > Vault > Files, and View > Vault > Parts views menus in an
out-of-box application. To enable the Edit User Attributes dialog box, edit the
$EPD_HOME/data/app-defaults/$LANG/Edmgui file:
1.

Delete the comment symbol (!) from the following lines:
!Edmgui.E240.textValue
!Edmgui.E240.source

2.

Add E240 at the end of the Edmgui.Edit.contents menu list.

Inconsistencies in the User Interface
After enabling the Edit User Attributes dialog box, the following inconsistencies
occur in the User Attributes panels. These inconsistencies do not affect the
database.
• Changing Attribute Values — If you edit an attribute value and open the Edit
User Attributes dialog box again, the Attribute Value field shows the previous
value rather than the changed one.
• Deleting Attributes — When you select an attribute and click Delete, the
attribute value is deleted but the attribute name is still displayed in the list. The
attribute name is deleted only when you click OK.
• Creating New Attributes Names — Newly created attribute names are not
associated with an object.
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Workaround for Inconsistencies
To work around these inconsistencies for attribute values, use the Vault
command-line interface to edit the values.
• To add a new instance or change the value of a user attribute, use the
ciassociat command:
ciassociat object-name=<file/part name>
object-type=<file/part>
input-attrs=<attribute filename that holds
the value of all attributes, the instance
number and the value>

The format of the attribute file is as follows:
ATTRIBUTE_NAME(instance number)=
attribute_value

• To change the value of an attribute, use the cichguattr command:
cichguattr object-name=<file/part name>
object-type=<file/part>
input-attrs=<attribute filename that holds
the value of all attributes, the instance
number and the value>

GTM Support
For all GTM commands, ARGV8 = EDM14.0.0.
The General Trigger Manager (GTM) server process supports the CHGFREV
command in addition to 22 other commands. See Chapter 5, “Configuring General
Trigger Manager,” of the Vault Programmer Guide. The arguments for the
CHGFREV command follow:

CHGFREV
ARGV1=ct_oracleid, ct_oraclepw, ct_command, ct_wait, ct_location,
ct_severity, ct_release, ct_userid, selscope, selname, revision,
currclass, currprojid, currstatus_cd, newrevision, filepw
ARGV2 = pdmdm
ARGV3 = pdmdm
ARGV4 = CHGFREV
ARGV5 = 1
ARGV6 = 0
ARGV7 = I
ARGV8 = EDM14.0.0
ARGV9 = EDMADMIN
ARGV10 = F SELSCOPE of object (F-File, P-Part, L-List, C-Catalog,
D-Directory)
ARGV11 = FILESP5 SELNAME of object - unique id for database

Optegra 15.0 Release Notes

1-7

Issues and Considerations
Vault

ARGV12 = A2 REVISION level of object
ARGV13 = A1 NEW REVISION OF OBJECT
ARGV14 = ARGV30 = NO_VALUE NOT USED

The General Trigger Manager commands that were previously documented in the
Vault Manager Guide are now part of the section, “Commands Supported by
GTM” of Chapter 5, “Configuring General Trigger Manager,” of the Vault
Programmer Guide.
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Future Support for Optegra PC Client
For technical reasons, PTC will not be able to support the existing Locator/PC and
Admin/PC in the next release of Optegra, that is, after Optegra 15.0. This can
affect the support for Optegra Vault Interface for AutoCAD that uses the same
technology used by Locator/PC and Admin/PC. It is undecided at this time how
this functionality will be provided in a future release of Optegra.
Therefore, the Optegra 15.0 PC Client has been modified to include the command
line interface to facilitate the use of other methods that support customizations and
communication with the Vault server. In addition, many Locator/PC and
Admin/PC functions are available with EPD.Connect.
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